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Workshop
Windows XP

Cleaning your PC
สารพดัวิธีทำใหพี้ซีของคณุสะอาด...
การดแูลคอมพวิเตอรส์ะอาดอยูเ่สมอ ถอืเปน็สิง่ที่
มคีวามสำคญัเชน่กนั เพราะหากคณุไมไ่ดท้ำความสะอาด
คอมพวิเตอรเ์ปน็ประจำแลว้ละ่ก ็มนักอ็าจทำให้
คอมพวิเตอรข์องคณุมปีระสทิธภิาพลดลง
รวมทัง้ยงัอาจสง่ผลตอ่สขุภาพของคณุอกีดว้ย

ความสกปรกซึ่งสะสมลงไปใน
คอมพิวเตอร์ จะทำให้คุณเสียเวลา
เงินทอง แถมยังทำให้พีซีของคุณมี
ประสิทธิภาพ ที ่ลดลงอย่างมาก
นอกจากนั้นความสกปรกดังกล่าว
ยังส่งผลเสียต่อสุขภาพของคุณ
อีกด้วย ดังน้ันใน Workshop น้ีเราจะ
บอกให้คุณทราบว่า คุณถึงกลวิธีที่
จะช่วยให้คุณสามารถแปลงสภาพ
พ ีซ ี ให ้สะอาดหมดจดมากข ึ ้น
จนมีประสิทธิภาพที่ดีขึ ้นแถมยัง
อาจช่วยให้คุณไม่ต้องเขียนลาป่วย
อกีดว้ย
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พีซีสกปรกก่อปัญหาอยา่งไรบา้ง?
เมื ่อตอนที่คุณคิดทำความสะอาดบ้าน

ครัง้ใหญ ่ คณุคงมกัไมค่อ่ยคดิถงึการทำความ
สะอาดคอมพิวเตอร์เป็นสิ่งแรกสักเท่าใดนัก
แต่ทว่าการดูแลคอมพิวเตอร์สะอาดอยู่เสมอ
ถือเป็นสิ่งที่มีความสำคัญเช่นกัน เพราะหาก
คุณไม่ได้ทำความสะอาดคอมพิวเตอร์เป็น
ประจำแล้วล่ะก็ มันก็อาจทำให้คอมพิวเตอร์
ของคุณมีประสิทธิภาพลดลง รวมทั้งยังอาจ
ส่งผลต่อสุขภาพของคุณอีกด้วย

เม่ือคุณเคาะนิว้บนคย์ีบอร์ดเพือ่พยายาม
เรียกโปรแกรมบางชนิดขึ ้นมา คุณอาจจะ
เจอปัญหา จากระบบทีไ่ม่เป็นระเบียบก็เป็นได้
สาเหตุเพราะ Windows XP ของคุณมี
ประสทิธภิาพลดลง จากวนัเวลาทีผ่่านไป ซ่ึงก็
เนื่องมาจากมันรวบรวมข้อมูลขยะเอาไว้ โดย
ในขณะที่คุณติดตั้งโปรแกรม เซฟหรือเรียก
ใช้ไฟล์  และทำสิง่ตา่งๆ ตามทีค่อมพวิเตอรถู์ก
ออกแบบมาให้ทำ ทำให้ไฟล์ชั่วคราวถูกสร้าง
ขึ้นมาในจุดที่คุณเข้าไปไม่ถึง เศษของข้อมูล
ก็จะถูกท้ิงเอาไว้  และกว่าท่ีคุณจะรู้ตัว คุณก็จะ
เจอกับระบบที่ยุ่งเหยิงเข้าให้เสียแล้ว

สุขภาพและอนามยั
ข้อมูลดิจิทัลที่ยุ่งเหยิงไม่ใช่ปัญหาเพียง

อย่างเดียวของพีซี คุณต้องคิดถึงสิ่งที่คุณทำ
ขณะทีใ่ช้คอมพวิเตอรอ์ยู ่คนสว่นมากชอบจบิ
กาแฟในขณะทีก่ำลังทำงานอยู่ คนบางคนอาจ
ชอบกินขนมขบเคี้ยวขณะที่ใช้คอมพิวเตอร์
ไปด้วย หรือบางคนชอบใช้นิ้วเกาผม ขยี้ตา
หรอืเกาสว่นตา่งๆ ของรา่งกายตวัเอง เปน็ตน้
ทำให้คีย์บอร์ดคอมพิวเตอร์ของคุณจึงกลาย
เป็นแหล่งเพาะเชื้อแบคทีเรีย เนื่องจากเรามัก
ไม่ค่อยล้างมือก่อนและหลังการใช้คีย์บอร์ด
หรือแม้แต่การใช้คอมพิวเตอร์ตามท่ีสาธารณะ

อยา่งอนิเทอรเ์นต็คาเฟห่รอืหอ้งสมดุ คณุลอง
คิดเอาเองก็แล้วกันว่าคีย์บอร์ดคอมพิวเตอร์ที่
ใช้กันหลายๆ คนนั้นจะมีเชื้อโรคอะไรสะสม
เอาไว้มากขนาดไหน หลังจากท่ีมีคนใช้งานเป็น
จำนวนมาก และนำเอาสิง่ทีพ่วกเขาเคยสมัผัส
มาใส่ลงไป ดังนั้นจึงไม่ใช่เรื่องที่น่าแปลกใจ
แต่อย่างใดที่คีย์บอ ร์ดกับเม้าส์ก็คือจุดที่มี
ความเสี่ยงต่อสุขภาพและอนามัยของเราเป็น
อย่างยิ่ง

คุณสามารถทำความสะอาดคีย์บอร์ดได้
โดยง่าย โดยใช้ผ้าสะอาดชุบน้ำยาฆ่าเชื ้อ
หมาดๆ เช็ดถูก การทำแบบนี้อาจไม่ถึงกับ
มาตรฐานของโรงพยาบาล แต่การเช็ดถูเป็น
ครั ้งคราว และการล้างมือก่อนที่จะไปปรุง
อาหารและหลงัจากเข้าห้องน้ำก็น่าจะเพียงพอ
แล้ว  จากนัน้คีย์บอร์ดก็จะไม่ทำใหคุ้ณป่วยอีก
ต่อไป

อย่างไรก็ตามผู้ใช้ซึ่งอยู่แผนกบริการของ
โรงพยาบาลควรจะเปลี่ยนคีย์บอร์ดใหม่เป็น
ประจำ เนื่องจากแม้แต่ใช้น้ำยาฆ่าเชื้อเป็น
ประจำแลว้กยั็งอาจเปน็ส่ิงทีไ่ม่เพยีงพอ ดังนัน้
ถ้าหากคุณต้องการรักษาสุขภาพของตนเอง
คุณต้องทำความสะอาดคย์ีบอร์ดคอมพิวเตอร์
ทุกซอกทุกมุมทุกปี

นอกเหนือจากการใช้ผ้าอุดจมูกและถุงมือ
ยาง เพือ่ทำความสะอาดคอมพวิเตอรข์องคณุ
แลว้  คณุยงัจำเปน็ตอ้งมคีวามรูบ้างอยา่งเพือ่
กำจัดไฟล์ขยะที่ทำให้คอมพิวเตอร์ของคุณมี
ประสิทธิภาพลดลงทิ ้งไปด้วย  ขั ้นตอนนี ้
เกี่ยวข้องกับการค้นหาและลบไฟล์ที่ไม่จำเป็น
ทิ้งไป บวกกับการปรับแต่งอีกเล็กน้อยเพื่อ
ทำใหพ้ซีีของคณุมปีระสทิธภิาพทีด่ขีึน้  แตเ่รา

ใช้โปรแกรม Norton Ghost 9
เพ่ือแบค็อพัฮาร์ดดิสกท์ัง้หมดของคณุ

การสรา้งจดุโอนถา่ยขอ้มลูกลบัคนืไมใ่ช่ส่ิงที่
ใช้แทนการแบค็อพัข้อมลูทัง้หมดได้

ต้องขอเตือนคุณก่อนว่าถ้าหากคุณลบไฟล์ออก
หรือทำอะไรผิดพลาดบางอย่างในขณะที่ทำ
ความสะอาด คุณอาจจะทำให้ไฟล์สำคัญ
สูญหายหรืออาจทำให้พีซีไม่อาจทำงานได้อีก
ต่อไปก็เป็นได้

มาตรการปอ้งกัน
คุณต้องเตรียมการล่วงหน้าก่อนที่คุณจะ

เร่ิมทำความสะอาดไฟล์ เพ่ือปกป้องคุณเองจาก
การสร้างความผิดพลาดราคาแพง ข้ันตอนแรก
ก็คือ การแบกอัพข้อมูลสำคัญของคุณเสียก่อน
ถ้าหากต้องการสร้างความม่ันใจว่าคุณสามารถ
ย้อนกลับไปสู่สภาพเดิม ก่อนที่คุณจะเริ่มทำ
ความสะอาด คุณควรใช้เครื ่องมือโคลนนิ่ง
อยา่ง Norton Ghost 9 เปน็ตน้

โปรแกรมนีข้อง  Norton ยอมใหค้ณุสรา้ง
โคลนนิงของฮาร์ดดิสก์ขึ้นมา หรือเฉพาะแค่
พาร์ทิชันของวนิโดวสไ์ปเก็บเ อาไว้ในพาร์ทิชัน
อ่ืนหรอืไดรฟ์อืน่ๆ  วธิกีารทีด่ทีีสุ่ดกค็อื กอ็ปป้ี
ไฟล์ไปเก็บเอาไว้ในแผ่น CD หรือ DVD
เนื่องจากแผ่นพวกนี้สามารถถอดออกจากพีซี
ของคณุได ้ แมว้า่การกอ็ปป้ีขอ้มูลใส่แผน่  CD
หรือ DVD จัดเป็นวิธีการที่ช้ากว่าการสร้าง
อิมเมจไปเกบ็เอาไวใ้นฮารด์ดสิก์ก็ตาม แตคุ่ณ
ควรทำการแบกอพัเตม็รูปแบบไปเกบ็เอาไวใ้น
ส่ือข้อมูลแบบเคล่ือนย้ายได้เป็นคร้ังคราวจะดีกว่า

การสร้างจุดโอนถ่ายข้อมูลกลับคืนก็จะ
เป็นสิ่งที่ช่วยอำนวยความสะดวกให้คุณได้
เช่นกัน วิธีการนี้เหมาะที่จะใช้ควบคู่กับการ
แบ็คอัพ แต่คุณไม่ควรใช้วิธีการเพียงแบบเดียว
โดยเด็ดขาด วิธีการสร้างจุดโอนถ่ายข้อมูล
กลับคืนทำได้โดยการใช้เมนู  Start>Programs
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02 แยกแยะไดรเวอร์
เลือกปุ ่มที ่เหมาะสมเพื ่อดูรายชื ่อของ

ไดรเวอร์ที่คุณต้องการ ให้คุณเลือกไดรเวอร์ที่
คุณต้องการแบกอัพหรือคุณอาจจะคลิกที ่
Select All ก็ได้ และเมื่อคุณคลิก Backup
Selected Drivers จากนั ้นไฟล์ไดรเวอร์
ทั ้งหมดจะถูกเซฟเอาไว้ในตำแหน่งที ่ระบุ
เอาไว้ หลังจากคุณทำข้ันตอนน้ีเสร็จแล้วให้ปิด
โปรแกรมได้

03 ก็อปปีข้้อมลูเก็บเอาไวใ้นซดีี
เข้าไปในโฟลเดอร์ที่คุณแบกอัพไดรเวอร์

เอาไว ้ เลอืกไฟลท์ัง้หมดจากนัน้คลกิเมา้สปุ่์ม
ขวาเพื่อส่งไฟล์เหล่านั้นไปยังไดรฟ์บันทึกซีดี
หรือคุณอาจจะใช้โปรแกรมบันทึก CD หรือ
DVD ก็ได้ ในตอนนี้คุณจะมีแผ่นดิสก์แบบ
เคลื่อนย้ายได้ ที่เก็บไฟล์ไดรเวอร์ทั้งหมดของ
คุณเอาไว้แล้ว้ซึ่งจะเป็นวิธีการที่มีประโยชน์
อย่างมาก

01 ตำแหนง่แบ็คอพั
ก่อนอื่นคุณจำเป็นต้องติดตั้งและสั่งงาน

โปรแกรม Driver Guide Toolkit จากเวบ็ไซต์
www.driverguidetoolkit.com หรือติดตัง้จาก
ซีดีที ่แถมมาจากนิตยสารของเราเสียก่อน
จากน้ันคลิกท่ีปุ่ม Backup Drivers เลือกหัวข้อ
Select folder for driver  backup  เล่ือนไปยงั
ตำแหนง่ทีค่ณุเกบ็ไดรเวอรแ์ลว้คลกิ OK แคน่ี้
คุณก็สามารถสแกนหาไดรเวอร์ทั้งหมด หรือ
เฉพาะไดรเวอร์ที่ไม่ใช่ของไมโครซอฟท์ก็ได้

>Accessories>SystemTools>System Restore
แล้วเลือกสร้างจุดโอนถ่ายข้อมูล กลับคืนข้ึนมา
คุณจะทำให้ระบบมีสภาพย้อนกลับมาสู่จุดนี้
ได้เมื่อถึงคราวจำเป็นขึ้นมา

อย่างไรก็ตามการแบกอพัแบบเต็มยศก็ยัง
มีจุดอ่อนบางอย่างซ่อนอยู่เช่นกัน เพราะคุณ
สามารถใช้แบกอัพเพ่ือทำให้ระบบมีสภาพแบบเดิม
เหมอืนกอ่นทีท่ำการแบกอพัได ้แตข่ยะซึง่คณุ
หวังท่ีจะกำจัดท้ิงไปก็จะหวนกลับมาเหมือนเดิม
คุณสามารถโอนถ่ายไฟล์ทีละไฟล์จากไฟล์
อิมเมจได ้แตว่ธิกีารนีจ้ะยุง่ยากพอสมควร

ไดรเวอรแ์ละรีจีสตรี
การแบ็คอัพองค์ประกอบส่วนที่มีความ

สำคัญของ Windows XP เอาไว้จัดว่าเป็น
ความคดิทีด่ ี ส่วนทีว่า่กค็อื ดไีวซไ์ดรเวอรแ์ละ
รีจีสตรี เพื่อที่คุณจะได้โอนถ่ายข้อมูลเหล่านี้
กลับคืนโดยไม่พ่วงขยะติดมาด้วย

สิ่งที่คุณสมควรกระทำอีกอย่างหนึ่งก็คือ
การแบ็คอัพดีไวซ์ไดรเวอร์ท้ังหมดท่ีมีอยู่ บริษัท
DriverGuide Toolkit มียูทิลิต้ีแบ็คอัพไดรเวอร์

สมบูรณ์แบบที่คุณสามารถนำไปทดลองใช้ได้
แล้ว ซึ่งคุณสามารถหาได้จากเว็บไซต์ www.
driverguidetoolkit.com แต่โปรแกรมให้
ทดลองใช้ได้ฟรีแค่สองวันเท่าน้ัน  ดังน้ัน คุณจง
อย่าดาวน์โหลดจนกว่าคุณจะพร้อมจริงๆ

ถ้าหากต้องการแบกอัพแบบง่ายๆ คุณควร
เลือกเมน ู Start>Run  แล้วพิมพ์คำวา่ regedit
ลงไปในช่อง Open จากน้ันเม่ือเข้ามาใน Registry
Editor  แลว้ ใหใ้ช้คำสัง่ File>Export จากนัน้
เข้าไปในจุดที่ต้องการเซฟไฟล์เก็บไว้ ใส่ชื่อ
ไฟลท์ีเ่หมาะสมแลว้คลกิ  Save คณุสามารถ
โอนถ่ายไฟล์กลับคืนมาใช้โดยการเลือกคำสั่ง
Import จากเมนเูดยีวกนั

ในตอนนี้เมื่อคุณเข้าใจปัญหาที่เกิดจาก
พีซีซึ่งเก็บข้อมูลไม่เป็นระเบียบดีขึ้น และคุณ
เตรียมมาตรการปอ้งกันง่ายๆ เอาไวแ้ล้ว คุณก็
จะเร่ิมต้นทำความสะอาดพีซีอย่างจริงจังได้แล้ว

ลดความแออดัยัดเยียดของหนา้จอเดสก์ทอป
คนบางคนทำสิ่งต่างๆ อย่างเป็นระเบียบ

ในขณะที่อีกหลายคนพยายามทำตัวให้เป็น

น่ีคือ พีซีสกปรกไร้ประสิทธิภาพและเป็นอันตราย
ต่อสุขภาพ พีซีไม่ได้ถูกออกแบบมาให้ทำงาน
แบบนี ้แตถ่า้หากคณุปฏิบัติตามคำแนะนำ
ของเราแลว้คณุจะเหมอืนกบัได้พีซีเครือ่งใหม่
มาไว้ครอบครอง

ระเบียบเช่นกัน ถ้าหากคุณจัดอยู่ในกลุ่มหลัง
นี้แล้วละก็ คุณอาจกำลังพยายามเริ่มทำตัว
ให้มีระเบียบมากขึ้น สิ่งแรกที่คุณมักทำก็คือ
การจัดเก็บเอกสารเข้าแฟ้มอย่างเป็นระเบียบ
จากน้ันไม่นานนักคุณอาจจำเป็นต้องใช้เอกสาร
หนึ่งหรือสองชุดในขณะที่คุณกำลังทำงานอยู่
ต่อมาเอกสารอื่นๆ ก็จะมานอนกองสุมอยู่บน
โต๊ะของคุณเอง โต๊ะของคุณก็จะไม่เป็นระเบียบ

 แบ็คอพัไดรเวอร ์การใชโ้ปรแกรม Driver Gudie Toolkit เพือ่แบค็อพัไดรเวอรก่์อนทีจ่ะทำความสะอาด
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02 ทำความสะอาดเดสกท์อป
ในหัวข้อ General คุณสามารถกำหนด

ได้ว่าต้องการให้แสดงไอคอนระบบอะไรบ้าง
ให้คุณยกเลิกการกาเครื่องหมายหน้าหัวข้อที่
คณุไมต่อ้งการทิง้ไป เชน่  My Computer, My
Documents และ Internet Explorer เปน็ตน้
จากนั้นในหัวข้อ Desktop Cleanup ให้กา
เคร่ืองหมายหน้าหัวข้อ Run Desktop Cleanup
Wizard every 60 days คลกิ Clean Desktop
Now

01 ปรบัแตง่เดสก์ทอป
คลิกเม้าส์ปุ่มขวาตรงไหนก็ได้ในเดสก์ทอป

แลว้เลอืกหวัขอ้ Properties จากเมนทูีป่รากฏ
ขึ้นมาในกรอบ Properties ให้เข้าไปในหัวข้อ
Desktop  ซึ่งตรงจุดนี้คุณสามารถแก้ไขภาพ
แบคกราวน์ได้ นอกจากนั้นคุณยังสามารถ
เรียกหัวข้อทำความสะอาดโดยการคลิกที ่
Customize Desktop ไดด้ว้ย

03 ชอรต์คทัท่ีไมไ่ดใ้ชง้าน
เม่ือ Desktop Cleanup Wizard เร่ิมทำงาน

คลิก Next จากน้ันระบบจะกาเคร่ืองหมายหน้า
หัวข้อไอคอนที่คุณไม่ค่อยได้ใช้งาน คลิกที่ชื่อ
ไอคอนอื่นๆ ที่คุณต้องการลบทิ้งไป จากนั้น
คลิก Next แล้วยืนยันการกำจัดไอคอนโดยการ
คลกิที ่Finish จากนัน้ไอคอนเหลา่นีจ้ะถกูยา้ย
มาอยู่ในโฟลเดอร์ที่ชื ่อ Unused Desktop
Shortcuts

อีกต่อไป เพียงเพราะคุณไม่ต้องการเดินย้อน
กลับไปหยิบเอกสารบ่อยๆ นั่นเอง ก่อนที่คุณ
จะรู้ตัว โต๊ะของคุณก็จะเต็มไปด้วยเอกสาร
จำนวนมาก จนคุณไม่มีที่เหลือจะวางสิ่งอื่นๆ
อีกต่อไป

หนา้จอเดสกท์อปของ Windows XP ยอม
ให้คุณใส่ชอร์ตคัทของโปรแกรมที่คุณใช้เป็น
ประจำเอาไว้ท่ีน่ี หรือปล่อยไฟล์ต่างๆ เอาไว้ท่ีน่ี
เพื่อให้คุณพร้อมที่จะใช้งานได้โดยง่าย ดังนั้น
หน้าจอเดสก์ทอปจึงเหมาะที่จะเป็นสถานที่
ช่ัวคราว ท่ีคุณจะใส่ส่ิงต่างๆ ท่ีคุณกำลังทำงาน
ค้างเอาไว้ แต่ปัญหาก็คือ ในเวลาไม่นานนัก
สถานทีช่ั่วคราวดงักล่าวอาจกลายเปน็สถานที่
ถาวร และสิ่งต่างๆ ก็เริ ่มไร้ระเบียบจนคุณ
ไม่อาจควบคุมได้อีกต่อไป

ทำความสะอาด
การทำความสะอาดหน้าจอเดสก์ทอป

ไม่ใช่เรื่องใหญ่ ตราบเท่าที่คุณทำเรื่องนี้เป็น
ประจำ คุณสามารถกำจัดชอร์ตคัทที่คุณไม่
จำเป็นต้องใช้อีก โดยการลากและปล่อยลง

การใชผ้า้บางๆ ทำความสะอาดอยา่งรวดเรว็
จัดว่าใช้ได้ในระดับหนึ่ง แม้อาจไม่ถึงมาตรฐาน
ความสะอาดของโรงพยาบาลกต็าม

ไปในถงั Recycle bin แตถ่า้หากคณุตอ้งการ
เลือกชอร์ทคัทหลายๆ อันพร้อมกันให้คุณ
กดปุม่ [Ctrl]  คา้งเอาไว ้ จากนัน้คณุกจ็ะเลอืก
ส่ิงที่ต้องการแล้วลากมาทิ้งในเวลาเดียวกันได้
ถ้าหากต้องการย้ายไฟล์ไปยัง My Documents
ให้คุณคลิก Start>My Documents จากนั้น
เลือกไฟล์ที ่คุณต้องการย้าย ในตอนนี้คุณ
สามารถย้ายไฟล์จากหน้าจอเดสก์ทอปไปไว้
ในโฟลเดอร์ที่เปิดค้างเอาไว้ได้แล้ว

แม้ว่าการทำความสะอาดจัดเป็นเร่ืองง่ายๆ
ก็ตาม แต่เรามักจะลืมเป็นประจำ ดังนั ้น
ไมโครซอฟท์จึงได้พัฒนายูทิลิตี ้แบบง่ายๆ
เพ่ือทำส่ิงน้ีให้คุณแทน ยูทิลิต้ีดังกล่าวท่ีมีช่ือว่า
Desktop Cleanup Wizard ซึ่งจะช่วยให้พีซี
ของคุณสะอาดอย่างรวดเร็วภายในเวลา 60 วัน
วิซาร์ดดังกล่าวจะรวบรวมชอร์ทตคัททั้งหมด
ที่คุณไม่ค่อยได้ใช้งาน จากนั้นนำไปใส่เอาไว้
โฟลเดอร์ใดโฟลเดอร์หนึ ่งของเดสก์ทอป
โฟลเดอรด์งักลา่วมกัมช่ืีอวา่  Unused  Desk-
top Shortcuts และคุณสามารถใช้ชอร์ตคัท
เหล่านี้ได้ โดยการเปิดโฟลเดอร์ดังกล่าวแล้ว

คลิกเม้าส์สองครั ้งยังชอร์ตคัทที ่ต ้องการ
การย้ายไอคอนท่ีไม่ค่อยมีการใช้งานออกไปจะ
ทำให้คุณค้นหาส่ิงต่างๆ ในเดสก์ทอปได้ง่ายข้ึน
เนื่องจากในหน้าจอจะมีเฉพาะชอร์ตคัทที่คุณ
ใช้เป็นประจำเท่านั ้น คุณสามารถสั ่งงาน
วิซาร์ดดังกล่าวนด้วยมือทุกครั้งที่คุณต้องการ

นอกจากน้ันคุณยังสามาถรนำเอาชอร์ตคัท
กลับมายังหน้าจอเดสก์ทอปได้โดยง่ายอีกด้วย
วิธีการก็คือเปิดโฟลเดอร์ Unused Desktop

 Dedktop Cleanup Wizard วธีิการจดัระเบยีบไอคอนในเดสกท์อปอยา่งรวดเรว็และงา่ยดาย
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Shortcuts จากน้ันก็ลากชอร์ทคัทท่ีคุณต้องการ
กลับมายังเดสก์ทอปเท่านั้นเอง

เปล่ียนความถีข่อง Desktop Cleanup
Wizard

นอกจากน้ันคุณยังสามารถเปล่ียนความถี่
ในการทำงานของ  Desktop Cleanup Wizard
โดยการแก้ไขรีจีสตรีได้ด้วย แต่ก่อนที่คุณจะ
ทำขั้นตอนนี้ สิ่งสำคัญก็คือคุณจำเป็นต้อง
แบ็คอัพรีจีสตรีเสียกอ่น วิธีการกคื็อให้ใช้คำสัง่
Start>Run แล้วพิมพ์คำว่า regedit ในบาร์
Open คลิก OK จากน้ันเลือกเมนู File>Export
>All แลว้ตัง้ชือ่ไฟลท์ีต่อ้งการแบค็อพั บวกกบั
ตำแหน่งที ่ต ้องการเก็บไว้แล้วคลิก Save
จากน้ันขยายหัวข้อ HKEY_CURRENT_USER
เพื่อให้แสดงคีย์ต่อไปนี้ HKEY_ CURRENT
_USER\Software\Microsoft\Windows\Curre
ntVersion\Explorer\Desktop\CleanupWiz
คลกิเมา้สปุ่์มขวาทีค่า่ Days between clean
up จากนั้นเลือก Modify เลือก Decimal
จากน้ันใส่ตัวเลขจำนวนวนัท่ีคุณต้องการให้ทำ
ความสะอาดเดสก์ทอป ปิด regedit แล้วสตาร์ท
พซีีใหม่

หน้าจอเดสก์ทอปไม่ใช่จุดเดียวที่จะได้
ประโยชน์จากการทำความสะอาดดงักล่าว My
Documents ก็เหมือนกับตู้ใส่เอกสารท่ีคุณเก็บ
ไฟล์ทั้หมดเอาไว้ขณะที่คณุใช้พีซี สิ่งที่เหมือน
กับตู้ใส่เอกสารจริงๆ ก็คือเอกสารที่คุณใส่
เก็บไว้อาจค่อนข้างหลากหลาย จนทำให้ตู้
เอกสารไม่มีระเบียบอีกต่อไป ถ้าหากคุณใส่
เอกสารลงไปแล้วต้องรีบปิดประตูอย่างรวดเร็ว
เพราะกลัวมีอะไรหล่นลงมา คุณน่าจะเจอ
ปัญหาโฟลเดอร์ My Documents ที่ไม่เป็น
ระเบยีบเขา้ใหแ้ลว้ ดงันัน้ไดเ้วลาทีค่ณุตอ้งจดั
ระเบยีบ My Documents โดยการเลอืกวา่จะ
เก็บไฟล์อะไรเอาไว้บ้างและจากนั้นก็แยกไฟล์
ออกเป็นหมวดหมู่ตามโฟลเดอร์และซับโฟลเดอร์
ต่างๆ

จัดระเบียบ My Documents
โดยปกติแล้วแอพพลิเคชันส่วนใหญ่มัก

เลือกที่จะเซฟไฟล์ที่คุณสร้างขึ้นมาเก็บเอาไว้
ใน My Documents เพือ่แยกงานของคณุเอง
จากไฟล์อื่นๆ ที่แอพพลิเคชันและ Windows

XP จำเปน็ตอ้งใช ้My Documents มีโฟลเดอร์
ยอ่ยอยูแ่ลว้ชือ่ My Music, My Pictures, My
Videos และ My e-Books ซ่ึงถือเป็นคำแนะนำ
เบื้องต้นในการแยกไฟล์ประเภทต่างๆ แต่คุณ
ก็ยังสามารถเลอืกเซฟไฟลป์ระเภทตา่งๆ ลงไป
ในตำแหน่งที่คุณต้องการได้ด้วย

ถ้าหากคุณไม่ได้ย้าย My Documents ไปไว้
ในที่อื่นๆ คุณน่าจะเจอโฟลเดอร์นี้อยู่ในไดร์ฟ
C:ท่ีC:\Documents and Settings\ [username]
\My Documents โดยที่ [username] ก็คือ
บัญชีชื่อ Windows XP ของคุณเอง ให้คุณ
สร้างโฟลเดอรแ์ละโฟลเดอรย์อ่ยขึน้มาภายใน
My Documents ตามประเภทของไฟล์หรือ
ประเภทของงานที ่ค ุณจำเป็นต้องใช้ไฟล์
เหล่านั้น ตัวอย่างเช่นคุณอาจต้องการเก็บ

ทำความสะอาดเมาส์ โดยปกตลูิกกล้ิงของเมา้ส์มักจะสกปรกไดง่้าย และอาจกอ่ปญัหาตา่งๆ
ไดม้ากมาย แตว่ธีิการทำความสะอาดมนัก็ไมไ่ดย้ากเย็นอะไร

A. วงแหวนลอ็ก
หมุนวงแหวนพลาสติกอันน้ีอกจากด้านล่าง

ของเม้าส์ เม้าส์บางรุ่นอาจใช้วิธีเลื่อนเข้าออก
แทนที่จะใช้วิธีหมุนก็เป็นได้ จากนั้นลูกบอล
ของเม้าส์จะร่วงออกมา

B. ฐาน
ฐานของเม้าส์อาจจะมีความสกปรกติดอยู่

ใช้ผ้าสะอาดกำจัดความสกปรกต่างๆ ทิ ้ง
ไปเสีย

My Documents มีโฟลเดอร์ My Music, My Video
และ My Pictures อยู่แล้ว คุณสามารถสร้าง
โฟลเดอร์อื่นๆ ให้สอดคล้องกับความต้องการ
ส่วนตัวได้

การค้นหาสิ่งต่างๆ จะทำได้ง่ายขึ้น ถ้าหากคุณ
จัดเรียงข้อมูลใน My Documents เรียงตามตัว
อักษรตั้งแต่แรก จากนั้นคุณก็คงไม่มีทาง
ทำอะไรหายได้ง่ายๆ อีกแล้ว
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C. ลูกกล้ิงเม้าส์
เม้าส์ของคุณอาจจะมีเซนเซอร์หมุนได้

แบบนี ้ 2-4 ชุด ซ่ึงคณุจะเจอคราบสกปรกตดิ
อยู่บริเวณศูนย์กลางของลูกกลิ้งใช้ก้านสำลี
และนิ้วมือเพื่อทำความสะอาดตรงจุดนี้

D. ลูกบอล
ลูกบอลอันนี ้จะเคลื ่อนผ่านเซนเซอร์ที ่

อยูใ่นเมา้ส ์ ใชผ้้าเชด็คราบสกปรกทีเ่หน็ไดชั้ด
ทิ้งไป

E. ก้านสำลี
ใช้ก้านสำลีทำความสะอาดลูกกลิ้งเม้าส์

โดยการชุบเอทธานอลหรือน้ำพอหมาดๆ แต่
ต้องไม่เปียกจนเกินไป

โดยการลบไฟล์เหล่าน้ีท้ิงไปด้วยตนเอง  ให้คุณ
เริ่มต้นเข้าไปดูในโฟลเดอร์ C:\Temp และ
C:\Windows\Temp โดยที่ C:\ ก็คือ ไดร์ฟที่
ตดิตัง้ Windows เอาไว ้ใหค้ณุไปยงัตำแหนง่
ดงักลา่ว แลว้เลอืกไฟลต์า่งๆ ทีเ่จอ คลกิเมา้ส์
ปุ่มขวาแลว้ใชค้ำสัง่ Delete

ไฟลช่ั์วคราวทีไ่ม่ไดถ้กูลบทิง้ไปอาจสง่ผล
กระทบต่ อประสิทธิภาพของพีซีเนื่องจากเมื่อ
โฟลเดอร์ชั ่วคราวมีขนาดใหญ่โตจนเกินไป
พีซีของคุณก็จะใช้เวลาเข้ามาสแกนตรงจุดนี้
นานข้ึน การทำความสะอาดโฟลเดอรเ์หล่าน้ีใช้
เวลาน้อยมาก แต่จะทำให้คอมพิวเตอร์ของคุณ
ตอบสนองได้ดีขึ้น ถ้าหากมีไฟล์สะสมในจุดนี้
มากเกินไป การสแกนโฟลเดอร์นี้จะทำให้พีซี
ของคุณทำงานช้าลง ดังนั้นคุณควรพิจารณา
ลบไฟล์เหล่านี้ทิ้งไปเสีย

ข้อมูลบัญชีเอาไว้ในโฟลเดอร์ที่ชื่อ Accounts
เป็นต้น

คุณยังสามารถจัดเรียงไฟล์และชอร์ทคัท
ไดโ้ดยงา่ย  โดยการคลกิเมา้สปุ่์มขวาทีใ่ดกไ็ด้
ในโ ฟลเดอรบ์ริเวณทีไ่ม่ตรงกบัออปเจก็ตใ์ดๆ
เมนูซ่ึงปรากฏข้ึนมาประกอบด้วยออปชันอย่าง
Arrange Icons By ให้คุณเลือกหัวข้อนี้แล้ว
จัดเรียงไฟล์ตามชื ่อ ขนาด หรือวันที ่ก็ได้
ถา้หากคณุเลอืก Name แลว้ ไฟลแ์ละไอคอน
ทั้งหมดจะเรียงตามลำดับตัวอักษรให้คุณเอง

ทำความสะอาดโฟลเดอรช่ั์วคราวและไฟลซ้์ำ
โดยปกติระบบปฏิบัต ิการ Windows

มักจะทำงานท่ีซับซ้อนบางอย่างซ่ึงเก่ียวข้องกับ
การก็อปปี้ไฟล์บางประเภทไปเก็บเอาไว้ใน
ตำแหน่ง ชั่วคราวเพื่อทำงานกับไฟล์เหล่านั้น
ข้ันตอนน้ีเป็นการเก็บไฟล์ต้นฉบับเอาไว้ในช่วง
ที่กำลังทำงานอยู่ ในกรณีที่เราจำเป็นต้องใช้
ไฟล์ดังกล่าวในที่อื่นๆ รวมทั้งช่วยให้พีซีของ
คุณเก็บไฟล์ที่จำเป็นต้องใช้ทั้งหมดเอาไว้ใน
ที่เดียวอีกด้วย

โฟลเดอร์ชั่วคราวมีความหมายตรงตาม
ชื่อก็คือ มันใช้เก็บไฟล์เอาไว้ชั่วคราวเท่านั้น
ถ้าหากไฟล์เหล่าน้ันไม่จำเป็นต้องใช้งานอีกต่อไป
มันก็จะถูกลบท้ิง อย่างไรก็ตามข้ันตอนดังกล่าว
ไม่ได้เกิดขึ ้นแบบอัตโนมัติเสมอไป ดังนั ้น
คุณจะสามารถประหยัดเนื ้อที ่บางส่วนได้

ลบไฟล์
ยูทิลิต้ีบางชนดิจะชว่ยใหคุ้ณลบโฟลเดอร์

ช่ัวคราวเหล่าน้ีได้โดยอัตโนมัติ เช่น คุณสามารถ
ดาวนโ์หลดโปรแกรม Empty Temp Folders
มาจาก www.danish-shareware.dk/soft/
emptemp/index.html จากนั้นให้คุณติดตั้ง
โปรแกรมนี้แล้วใส่ชื่อโฟลเดอร์ชั่วคราวที่คุณ
ต้องการทำคามสะอาดลงไปให้หัวข้อ Temp
Folders คุณสามารถลบไฟล์ในโฟลเดอร์เอง
หรือกำหนดให้โปรแกรมทำงานอัตโนมัติตาม
ช่วงเวลาที่กำหนดก็ได้ ในตอนนี้ให้คุณคลิกที่
File>Start>EmpRunner จากนัน้กำหนดชว่ง
เวลาที่จะทำการลบข้อมูลในโฟลเดอร์ คลิก
Start เพื ่อทำให้โปรแกรมทำงานในโหมด
แบ็คกราวน์
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โดยปกติแล้วเมื่อคุณติดตั้งโปรแกรมใหม่
ก็จะมีการใช้งานโฟลเดอร์ชั่วคราวเกิดขึ้น แต่
ข้อมูลในนี้มักไม่ได้ถูกลบทิ้งไป เมื่อขั้นตอน
การติดตั้งเสร็จเรียบร้อยแล้ว

อีกวิธ ีที ่ค ุณสามารถทำให้พีซีมีเนื ้อที ่
เพิม่ขึน้และมทีรพัยากรเหลอืมากขึน้ กค็อืการ
ยกเลิกการติดตั ้งโปรแกรมเหล่านั ้นทิ ้งไป
วิธีการที่ดีที่สุดก็คือ การใช้ยูทิลิตี้ยกเลิกการ
ติดตั้งของตัวแอพพลิเคชันเอง โดยคุณมักจะ
พบยูทิลิตี้ดังกล่าวได้ในเมนู Start แต่ถ้าหาก
คุณไม่เจอยูทิลิต้ีดังกล่าว ให้คุณเข้าไปใน Con-
trol Panel แล้วเลือกเมนู Add or Remove
Programs เพือ่ยกเลกิการตดิตัง้กไ็ด้

ในชว่งทีย่กเลกิการตดิตัง้โปรแกรม ระบบ
อาจจะสอบถามเกี่ยวกับไฟล์ที่จำเป็นต้องใช้
ร่วมกัน คำเตือนเกี่ยวกับการลบไฟล์ที่จำเป็น
ตอ้งใชร่้วมกบัโปรแกรมอืน่ๆ ถอืเปน็เรือ่งทีมั่ก
สร้างความเขา้ใจทีผิ่ดๆ ไดอ้ยูเ่สมอ เนือ่งจาก

วธีิลบไฟลซ้์ำซ้อน ด้วย EasyCleaner A. ค้นหาไฟลซ้์ำซ้อน
เรยีก Easy Cleaner ขัน้มา แลว้คลกิทีปุ่่ม
Duplicates เพือ่เรยีกยทูลิิตีต้วันีข้ึน้มา

B. เลือกไดรฟ์
เลือกไดร์ฟที่คุณต้องการค้นหาไฟล์ซ้ำซ้อน
ซึ่งโดยปกติโปรแกรมจไฮไลท์ไดร์ฟที่มีอยู่ทั้งหมด

C. ค้นหา
คลิกที่ปุ่มนี้เพื่อเริ่มต้นสแกนหาไฟล์ซ้ำซ้อน

D. ผลลัพธ์การคน้หา
รายชือ่เหลา่นีเ้ปน็รายการไฟลซ์ำ้ซอ้น
คุณสามารถลบไฟล์เหล่านี้ทิ้งไปได้อย่าง
ปลอดภัย

E. ลบ
เลือกไฟล์ที่คุณต้องการลบจากรายการ
จากนั้นคลิกปุ่มนี้เพื่อทำการลบ

F. บันทึก
ใช้ปุ่มนี้เพื่อเซฟรายชื่อไฟล์ซ้ำเก็บไว้
ในกรณีที่คุณจำเป็นต้องใช้ไฟล์เหล่านี้
ในภายหลัง

ไฟล์เหล่านั้นไม่ได้จำเป็นต้องใช้งานร่วมกัน
เสมอไป ถ้าหากคุณมั่นใจพอให้ลบไฟล์ที่ใช้
ร่วมกันทิ้งไปได้เลย แต่ถ้าหากคุณเจอปัญหา
ในภายหลัง คุณก็ยังสามารถติดตั้งโปรแกรม
นั้นใหม่  แล้วจึงค่อยยกเลิกการติดตั้งอีกครั้ง
แต่ครั ้งนี ้เลือกเก็บไฟล์ที ่ใช้ร ่วมกันเอาไว้
ทางเลือกอีกแบบหนึ่งก็คือ เลือกวิธีเก็บไฟล์
เหล่านั้นไว้  แต่จดชื่อและตำแหน่งที่เก็บไฟล์
ถ ้าหากคุณไม่เจอปัญหาใดๆ ให้ลบไฟล์
เหล่านั้นทิ้งไปได้ แต่ถ้าหากคุณเจอปัญหา
ให้ย้ายไฟล์กลับไปยังจุดที่เหมาะสม

ยูท ิล ิต ี ้ยกเล ิกการต ิดต ั ้งโปรแกรมมี
ประสิทธิภาพท่ีแตกต่างกันออกไป แต่โดยปกติ
มันมักจะทำความสะอาดได้ไม่ดีเท่าที ่ควร
รวมท้ังยังมักจะมีไฟล์หรือโฟลเดอร์เหลืออยู่ใน
ไดเรกทอร ีPrograms Files อีกดว้ย ส่ิงทีค่ณุ
ควรทำก็คือการทำความสะอาดพีซีซ้ำอีกครั้ง
หลังจากยกเลิกการติดตั้งโปรแกรมต่างๆ เพื่อ

ทำให้พีซีของคุณปราศจากไฟล์ขยะท่ีไม่จำเป็นอีก
ใหค้ณุเขา้ไปในโฟลเดอร ์Program Files และ
ลบไฟล์โฟลเดอร์ใดๆ ท่ีเก่ียวข้องกับอแพพลิเคชัน
ที่เพิ่งถูกยกเลิกการติดตั้งไป
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การทำความสะอาดงา่ยๆ
ถ้าหากการทำความสะอาดเองไม่ใช่สิ่งที่

คุณถนัดมากนัก คุณสามารถใช้โปรแกรมอย่าง
EasyCleaner ช่วยได ้โปรแกรมแจกฟรนีีผ้ลิต
โดยบริษัท ToniArts ซึ่งออกแบบมาเพื่อช่วย
คุณทำความสะอาดโดยเฉพาะ นอกจากนั้น
คุณยังสามารถใช้ฟังก์ชัน Add/Remove
ของโปรแกรมเพื่อกำจัดไฟล์ที่ไม่ต้องการได้

ส่วน Windows XP เองก็มียูทิลิตี้ Disk
cleanup wizard เชน่กนั ซ่ึงถอืเปน็วธิกีารเพิม่
พื้นที่ในฮาร์ดดิสก์ของคุณได้อย่างรวดเร็ว วิธี
การทำงานกค็อืเขา้ไปที ่Start>All Programs
>Accessories>System Tools>Disk Cleanup

01 งัดปุ่มตา่งๆ ออกมา
ถ้าหากต้องการทำความสะอาดคีย์บอร์ด

อย่างละเอียดแล้วละก็ คุณต้องงัดปุ่มทั้งหมด
ออกมาเสียก่อน ให้คุณใช้ไขควงหัวแบนงัด
ปุ่มตา่งๆ ขึน้ดา้นบนอยา่งระมดัระวงั คณุตอ้ง
จำเอาไวว้า่ปุม่แตล่ะปุม่มีสปริงรองอยู ่ ดงันัน้
คุณจำเป็นต้องคอยจับปุ่มตอนที่มันเด้งขึ้นมา
เอาไว้ให้ดี คุณต้องไม่งัดปุ่มออกมาแรงจน
เกินไป มิฉะน้ันแล้วคุณอาจทำใหตั้วล็อกหักได้
หลังจากที่ถอดปุ่มทั้งหมดออกมาแล้ว ใช้น้ำ
ผสมผงซกัฟอกออ่นๆ ล้างปุม่เหลา่นี้

02 ทำความสะอาดดา้นล่าง
ถ่ายภาพคีย์บอร์ดหรือใช้คีย์บอร์ดไดอะแกรม

เป็นตัวช่วยเตือนความจำวา่ปุ่มแต่ละปุ่มต้ังอยู่
ตรงไหนบ้าง ก่อนท่ีคุณจะทำการถอดปุม่แต่ละ
ปุ่มออกมาทำความสะอาดรอบๆ ฐานของปุม่
แต่ละปุ่ม เพราะเมื่อฐานของคีย์บอร์ดสะอาด
แลว้ ใหท้ำความสะอาดฐานยางของปุม่แตล่ะ
ปุ่มด้วย รวมทั้งในบางครั้งคุณอาจต้องถอด
ฐานยางออกมาทำความสะอาดด้วยก็เป็นได้
ฐานยางดังกล่าวใช้ลดแรงกระแทกขณะที่คุณ
เคาะคีย์บอร์ดอยู่

03 ใสปุ่่มกลับคนื
เม่ือปุ่มต่างๆ แห้งดีแล้ว คุณสามารถประกอบ

คีย์บอร์ดกลับคืนได้ คุณต้องนำฐานยางที่
ถอดออกมาใส่ลงไปก่อน จากน้ัน จึงค่อยใส่ปุ่ม
แตล่ะปุม่ลงไป  ขัน้ตอนนีน้า่จะเปน็แคก่ารกด
ให้ปุ่มเข้าที่เท่านั้น เว้นเสียแต่คุณทำตัวหนีบ
คีย์บอร์ดหักไปก่อนตอนที่ถอดปุ่มต่างๆ ออก
มา ใหใ้ช้ผ้าหมาดๆ ทำความสะอาดคยีบ์อร์ด
ท้ังหมดอีกคร้ัง แล้วปล่อยให้คีย์บอร์ดแห้งก่อน
ทีค่ณุจะใชง้านอกีครัง้

การทำความสะอาดคย์ีบอรด์ คณุสามารถทำความสะอาดคย์ีบอรด์อยา่งเหมาะสมได ้แตค่ณุตอ้งรือ้มนัออกมากอ่น

วิซาร์ด Disk Cleanup เป็นวิธีการง่ายๆ
ในการเพิม่พืน้ทีท่ีม่คีา่ในฮารด์ดิสก ์คณุสามารถ
เรียกวิซาร์ดตัวนี้ได้จากเมนู Start>All Programs>
Accessories>System Tools

Empty Temp Folders ช่วยใหก้ารทำความสะอาด
ไฟล์ช่ัวคราวยุง่ยากนอ้ยลง

Easy Cleaner คือ วิธีการง่ายๆ ท่ีช่วยให้คุณกำจัด
โปรแกรมเก่าๆ ที่คุณไม่ต้องการทิ้งไปได้

ไฟล์ชั่วคราว, ข้อมูลแคชของอินเทอร์เน็ตและ
ข้อมูลที่ถูกลบไปแล้วแต่ยังเหลืออยู่ในถัง Re-
cycle bin จากนั้นยูทิลิตี้จะทำการคำนวณ

เลือกฮาร์ดดิสก์และพาร์ทิชันที่คุณต้องการ
ทำความสะอาด จากน้ันคลิกปุ่ม OK วิซาร์ดจะ
ทำการตรวจสอบพืน้ทีต่า่งๆ ทีอ่ยูใ่นฮารด์ดสิก์
ของคณุ  จากนัน้ทำการคน้หาขอ้มูลตา่งๆ เชน่
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พื้นที่ที ่คุณสามารถประหยัดได้ โดยการลบ
ข้อมูลเหล่านี้ทีละชุด คุณสามารถคลิกหน้า
หัวข้อที่ต้องการลบทิ้งไปได้

พ้ืนท่ีท้ังหมดท่ีคุณจะได้รับคืนมา จะแสดง
เอาไว้ด้านบนรายการ ส่วนด้านล่างคุณจะเหน็
พื้นที่ที่คุณประหยัดได้ตามออปชันที่คุณเลือก
เอาไว ้คลกิปุม่ OK เพือ่ดำเนนิงานตอ่ วซิารด์
จะทำการลบไฟล์ที่คุณเลือกเอาไว้ และทำให้
ฮาร์ดดิสก์มีพื้นที่เพิ่มขึ้นอีกเล็กน้อย

ทำความสะอาดรจีีสตรี
รีจีสตรีเป็นระบบจัดเก็บข้อมูลขนาดใหญ่

ทีเ่กบ็ตวัแปรและรายละเอยีดตา่งๆ ของระบบ
ปฏิบัติการ Windows  เอาไว้ท้ังหมด รีจีสตรีถูก
สร้างขึ้นมาเพื่อช่วยให้เรากำหนดตัวแปรของ
ฮารด์แวร ์ซอฟตแ์วร ์และผูใ้ช้ไดใ้นคราวเดยีว
กัน จุดอ่อนของการนำเอาตวัแปรท้ังหมดมาไว้
อยู่ในที่เดียวกันแบบนี้ก็คือเมื่อรีจีสตรีเกิดเสีย
ขึน้มา เราอาจไมส่ามารถโหลด Windows ขึน้
มาได้อีกก็เป็นได้

อย่างไรก็ตามรีจีสตรีจะถูกแบกอัพอัตโนมัติ
ทุกครั้งเมื่อคุณบูตพีซี และคุณควรแบ็คอัพ

01 ขยายไฟล์
เมื่อคุณดาวน์โหลดยูทิลิตี้  RegClean

4.1a มาจากเวบ็ไซตด์าวนโ์หลดฟรหีลายแหง่
ส่ิงท่ีคุณได้มาก็คือไฟล์ถูกบีบอัดช่ือ regclean.
exe ท่ีสามารถขยายขนาดไดด้้วยตนเอง ดังน้ัน
เมื ่อค ุณเร ียกใช ้โปรแกรมนี ้ เป ็นคร ั ้งแรก
คุณต้องระบุว่าจะให้โปรแกรมท่ีถูกขยายขนาด
ไปเก็บเอาไว้ในที่ใด จากนั้นให้คุณเข้าไปใน
โฟลเดอร์นี ้ แล้วคลิกเม้าส์สองครั ้งที ่ไฟล์
regclean.exe อันใหม่

02 สแกนรีจีสตรี
RegClean จะเริม่ตน้ตรวจสอบรจีีสตรวีา่

มีปัญหาหรือวัตถุส่วนเกินใดๆ หรือไม่ในทันที
ถ้าหากยูทิลิตี้ไม่เจอความผิดปกติใดๆ คุณ
สามารถคลกิ Exit และปิดโปรแกรมได ้แต่ถ้ามี
ความผิดพลาดให้คลิกที่ Fix Errors จากนั้น
RegClean จะแกปั้ญหาแลว้สรา้งไฟล ์ Undo
Registry  ข้ึนมา ซ่ึงไฟล์ดังกล่าวจะถูกเซฟเอาไว้
ในโฟลเดอรเ์ดยีวกบัไฟล ์regclean.exe

03 การทำ Undo
ถ้าหากระบบของคุณมีปัญหาอันเป็นผล

ทีม่าจากการเปลีย่นแปลงของ RegClean  ให้
คุณเข้าไปในโฟลเดอร์ซึ่งเก็บไฟล์ regclean.
exe เอาไว้ ดับเบิลคลิกที่ไฟล์ Undo ไฟล์นี้มี
ชื่อว่า Undo บวกกับชื่อพีซี วันที่ และเวลา
เอาไว้ จากนั้นรีจีสตรีจะมีสภาพเหมือนตอน
ก่อนหน้าที่คุณจะทำการเปลี่ยนแปลงใดๆ

รีจีสตรีเสียก่อนท่ีคุณจะเร่ิมทำความสะอาดมนั
ถ้าหากมีปัญหาใดๆ เกิดข้ึน คุณก็เพียงแค่นำเอา
แบ็คอัพชุดใดชุดหนึ่งมาใช้เท่านั้นเอง ถ้าหาก
Windows XP ไม่สามารถเริม่ตน้ทำงานอยา่ง
ถูกต้องได้ ให้กดปุ่มรีเซ็ตที่อยู่ในพีซี ซึ่งเมื่อ
ระบบพบขั้นตอนการบูตที่ผิดพลาดไปแล้ว
คุณจะเห็นตัวเลือกหลายข้อปรากฏขึ้นมาบน
หนา้จอ ใหค้ณุเลอืกขอ้สุดทา้ยทีบ่อกวา่  Last
Known Good Configuration จากนั้น Win-
dows กน็า่จะสตารท์ไดต้ามปกติ

ค ุณสามารถเร ียกดูและแก้ไขร ีจ ีสตร ี
โดยใช้ยูทิลิตี้ Registry Editor (regedit) ได้
วธิกีารกค็อืคลกิที ่Start>Run  และพมิพค์ำวา่
regedit ในบาร ์Open เพือ่เริม่เรยีกโปรแกรม
จากนัน้คลกิ OK ส่ิงแรกทีค่ณุควรมองหากค็อื
การอ้างอิงไปยังโปรแกรมหรือฮาร์ดแวร์ที่คุณ
เพิ่งลบทิ้งไปเมื่อไม่นานมานี้ จากนั้นคุณจึง
ค่อยขยายหัวข้อหลักเพื่อดูหัวข้อย่อยได้

ถ้าหากจำเปน็ใหใ้ช้คำสัง่ Find เพือ่คน้หา
รายการที่คุณรู้สึกคุ้นเคย ให้ใช้คำสั่ง Edit>
Find และใส่บางส่วนของชื่อที่คุณต้องการ
ค้นหา คลิก Find Next เพื ่อค้นหาสตริง

ข้อความในคย์ี ข้อมูล หรือค่าต่างๆ ของรีจีสตรี
ต่อไป

คุณสามารถทำขั้นตอนนี้ซ้ำได้มากเท่าที่
คุณต้องการ เพื่อค้นหาข้อมูลอ้างอิงทั้งหมด
รวมท้ังคุณต้องตรวจดูว่าข้อมูลอ้างอิงแต่ละจุด
อยู่ตรงไหนดว้ย ข้อความประกอบของสตรงิจะ
เป็นตัวกำหนดวา่มันสมควรถูกลบท้ิงไปหรือไม่
ถ้าหากคุณไม่แน่ใจ คุณควรยกผลประโยชนใ์ห้
จำเลยไปก่อน

บางส่วนของรีจีสตรีตรวจสอบได้ง่ายกว่า
ส่วนอื่นๆ ดังนั้นคุณควรเข้ามาตรวจสอบตรง

การใช ้RegClean เพือ่ลดขนาดของรจีีสตรี
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จุดนี้ก่อน นั่นก็คือ ให้ขยายหัวข้อ HKEY_
LOCAL_MACHINE  รวมทัง้ทำแบบเดยีวกนั
กับหัวข้อย่อยซอฟต์แวร์ ซึ่งตรงจุดนี้เป็นจุด
ที่ตัวแปรของซอฟต์แวร์มาอยู่รวมกันมากที่สุด
และคุณน่าจะพบโฟลเดอร์ที่มีชื่อเหมือนกับ
โปรแกรม ที่คุณอาจแทบจำไม่ได้แล้วว่าเคย
ติดตั้งลงไปหรือเปล่า

นอกจากนัน้ คุณควรมองหาชือ่โฟลเดอร์ที
คุ่ณเพ่ิงลบท้ิงไปเม่ือไม่นานมาน้ี   จากน้ันขยาย
หัวข้อนั้นเพื่อดูเนื้อหาที่อยู่ภายใน คุณจะลบ
โฟลเดอร์น้ันได้ก็ต่อเม่ือคุณแน่ใจแล้วว่าโปรแกรม
อ่ืนๆ ไม่ไดใ้ช้ตวัแปรทีอ่ยูใ่นนัน้ดว้ย จากนัน้ให้
เข้าไปในหัวข้อ Hardware และลบข้อมูล
อ้างอิงเกี ่ยวกับอุปกรณ์ที่คุณถอดออกจาก
คอมพิวเตอร์ไปแล้วทิ้งไปด้วย

ในตอนนี้ให้คุณลองขยายหัวข้อ HKEY_
CURRENT_USER โดยใช้วิธีการเดียวกัน
ให้คุณเข้าไปในหัวข้อย่อย Software เพ่ือค้นหา
รายการทีไ่ม่จำเปน็  และถา้หากคณุรูสึ้กม่ันใจ
ให้ลบโฟลเดอร์นั้นทิ้งเหมือนกับขั้นตอนก่อน
หน้าน้ี  ข้อมูลส่วนใหญ่มักจะเหมือนกับ HKEY
_LOCAL_MACHINE ดงันัน้คณุจงึควรคน้หา

ลดความแออดัใน Startup
รายการของ Startup ที่มาจาก Startup

Group ของ Start Menu หรือมาจากรีจีสตรี
อาจส่งผลทำให้ มีโปรแกรมที่คุณไม่ต้องการ
ทำงานอยู่ในโหมด แบกกราวน์อย่างต่อเนื่อง
ขณะที่คุณใช้วินโดวส์อยู่  การทำแบบนี้ทำให้
สิ ้นเปลืองเมมโมรีและประสิทธิภาพในการ
ประมวลผลไปโดยไม่จำเป็น จนทำให้พีซี
ของคณุทำงานชา้ลง ถ้าหากคณุไม่ต้องการให้
โปรแกรมบางชนิดทำงานตลอดเวลาแล้วละก็
การปิดโปรแกรมไม่ให้ทำงาตอนสตาร์ทอัพจะ

ทำให้คุณมีทรัพยากรบางส่วนเหลือกลับมา
ยูทิลิต้ีอย่าง System Configuration Utility หรือ
MSConfig จะช่วยให้คุณทราบว่ามีโปรแกรม
ใดที่ทำงานตอนสตาร์ทอัพบ้างและแก้ไขตาม
ความเหมาะสมได้

วิธีการกคื็อ เขา้ไปที ่Start>Run แล้วพมิพ์
คำว่า msconfig ในบาร์ Open แล้วคลิกปุ่ม OK
จากนัน้ในหวัขอ้ General ใหเ้ลอืก Selective
Startup แล้วเข้าไปในหัวข้อ Startup เพื่อดู
รายการโปรแกรมท่ีเร่ิมทำงานพร้อมกับวินโดวส์
คุณสามารถยกเลิกการทำงานของโปรแกรมใดๆ

01 จอภาพแบบแบนราบ
จอ TFT (Thin Film Transistor) มักมเียือ่

บางๆ ปกคลุมจออยู่ และผลิตภัณฑ์ทำความ
สะอาดชนดิต่างๆ อาจก่อให้เกิดความเสยีหาย
จนจอไม่อาจทำให้มีสภาพเหมือนเดิมได้
การขดัถแูรงๆ อาจทำใหพ้ลาสตกิทีเ่คลอืบอยู่
หลุดออกมา ดังนั้นคุณควรใช้ผ้าสะอาดชุบ
นำ้หมาดๆ เชด็จอเบาๆ กเ็พยีงพอแลว้

02 จอภาพรุน่เก่า
จอ CRT (Cathode Ray Tube) ทำงาน

แบบเดียวกับจอทีวีทั ่วไป จอประเภทนี้จะ
ปล่อยไฟฟา้สถติยอ์อกมาดกัฝุน่ทีอ่ยูร่อบๆ ได้
คุณควรใช้ผ้าแห้งที่สะอาดปัดฝุ่นออก ส่วน
รอยเปื้อนที่ปรากฏอยู่บนหน้าจอให้ใช้น้ำยา
ทำความสะอาดพื้นผิวทั่วไปได้

03 สแกนเนอร์
สแกนเนอร์จำเป็นต้องพึ่งพาแผ่นแก้วที่

สะอาดมาก และคราบสกปรกใดๆ บนแก้ว ก็
จะติดไปยังภาพของคุณได้ ดังนั้น ในขณะที่
คณุทำความสะอาดสแกนเนอร ์คณุตอ้งระมดั
ระวังอย่างมาก เนื ่องจากรอยขีดข่วนเพียง
เล็กน้อยจะทำให้การสแกนในอนาคตของคุณ
เสียหายได้ คุณต้องทำความสะอาดแผ่นแก้ว
โดยใช้ผ้าลินินบางๆ แต่ห้ามใช้กระดาษชำระ
มิฉะนั้นเส้นใยในกระดาษอาจไปขูดขีดแก้วได้

การทำความสะอาด จอภาพและสแกนเนอร์

ข้อมูลที่ซ้ำซ้อนแบบเดียวกันด้วย
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โดยการยกเลิกการกาเคร่ืองหมายหน้าช่ือต่างๆ
จากน้ันบูตเคร่ืองใหม่เพ่ือดูว่าโปรแกรมท่ีหายไป
ส่งผลกระทบต่อวินโดวส์อย่างไรบ้าง ถ้าหากมัน
มีผลกระทบให้ย้อนกลับเข้ามาใน MSConfig
เพื ่อเร ียกโปรแกรมนั ้นกลับคืนมา ค้นหา
ตำแหน่งของโปรแกรมนั ้น โดยใช้คอลัมน์
Location จากนั้นให้คุณลองตัดโปรแกรมนี้
ออกจากสตาร์ทอัพโดยการปิดออปชัน to Start
With Windows ในแอพพลิเคชันตัวนี้ หรือ
ยกเลิกการติดตั้งโปรแกรมนั้น หรือแก้ไขใน
รีจีสตรี โดยเข้าไปดูใน HKEY_LOCAL_
MACHINE\SOFTWARE\Microsoft\Windows
\CurrentVersion\Run เพื่อค้นหารายการที่
เกี่ยวข้องกับการสตาร์ทอัพแล้วลบทิ้งไป

ตัวเลือกอตัโนมติั
การค้นหารายการต่างๆ ในรีจีสตรีแบบนี้

จำเป็นต้องใช้ความอดทนอย่างมาก นอกจากน้ัน
พวกเราส่วนใหญ่มักมองว่าการแก้ไขสิ่งต่างๆ
ด้วยตนเ องแบบน้ีเป็นเร่ืองท่ีน่ากลัวพอสมควร

ดังนั้นคุณจำเป็นมีความมั่นใจว่าคุณกำลังทำ
อะไรอยู่ แต่ถ้าหากคุณต้องการทางเลือกอื่นๆ
ที่ช่วยให้คุณมั่นใจยิ่งขึ้น เราขอแนะนำให้คุณ
ใช้โปรแกรมทำความสะอาดรีจีสตรีที ่มีอยู ่
มากมาย แถมบางชนิดยังแจกฟรีอีกด้วย แม้ว่า
โปรแกรมบางชนิดช่วยให้การทำความสะอาด
มีความยุง่ยากลดลงไดก็้ตาม  แตก็่ใช่ว่ามันจะ
ทำงานอย่างมีประสิทธิภาพทุกครั้งเสมอไป
ดังนั้นเมื่อคุณเลือกยูทิลิตี้ชนิดใดชนิดหนึ่งมา
ใช้แล้ว คุณควรสั่งงานยูทิลิตี้ดังกล่าวสัก 2-3
หน เพื่อทำความสะอาดรายการแปลกปลอม
ใหม้ากทีสุ่ดเทา่ทีจ่ะทำได้

RegClean เป็นโปรแกรมที่ไมโครซอฟท์
พัฒนาขึ้นมา แต่ไมโครซอฟท์ไม่ได้ให้บริการ
โปรแกรมนีแ้ลว้ เนือ่งจากมนัคอ่นขา้งเกา่มาก
อย่างไรก็ตามโปรแกรมน้ียังคงทำงานของตนได้เป็น
อย่างดี และคุณจะพบกับโปรแกรมนี้ได้ตาม
เว็บไซต์ดาวน์โหลดส่วนใหญ่ หรือง่ายกว่านั้น
คุณลองเข้าไปหามันในซีดีของเราดูสิ

นอกจากนั ้นคุณยังสามารถใช้ยูทิลิต ี ้

EasyCleaner  เพื่อสแกนหารีจีสตรีให้คุณได้
วิธีการก็คือ เรียกโปรแกรมขึน้มาแล้วคลิกท่ีปุ่ม
Registry จากนั้นเริ่มสแกนรีจีสตรีโดยคลิกที่
ปุ่ม  Find  เวลาในการสแกนจะขึน้อยู่กับขนาด
รีจีสตรีของคุณและจำนวนของรายการที่ไม่
จำเป็นซึ่งอยู่ในนั้น หลังจากที่ทำการสแกน
เสร็จแล้ว คุณจำเป็นต้องคลิกที่ Delete All
เพือ่ลบทกุอยา่งทิง้ไปจากนัน้คลกิ Close

A. Internet Options
เรยีก  Internet Explorer ขึน้มา แลว้เลอืก
เมน ูTools, Internet Options จากนัน้เลอืก
หวัขอ้ General ซ่ึงตรงจดุนีค้ณุสามารถ
จัดการกบัไฟล์ช่ัวคราวของ อินเทอรเ์น็ตได้แล้ว

B. ลบคุกก้ี
กดปุ่มนี้เพื่อลบไฟล์คุ๊กกี้ทั้งหมดที่บราวเซอร์
เก็บเอาไว้หลังจากเข้าไปเยี่ยมเว็บไซต์ต่างๆ

C. การกำหนดตวัแปร
ปุ่มนี้นำคุณไปสู่กรอบที่ช่วยให้คุณกำหนด
ขนาดและ ตำแหนง่ของไฟลช่ั์วคราวได้

D. ลบไฟล์
คลิกตรงจุดนี้เพื่อกำจัดเว็บเพจออฟไลน์
ที ่Internet Explorer เกบ็เอาไว้

E. จำนวนวนัในการเกบ็ History
กำหนดตัวเลขนี้ให้สอดคล้องกับจำนวนวันที่
คณุตอ้งการให ้Internet Explorer จำวา่
คุณเข้าไปในไซต์ใดบ้าง

วธีิทำความสะอาดแคช เพือ่ลบคุก๊ก้ีและเวบ็เพจทีไ่มต่อ้งการทิง้ไป

คณุสามารถใช ้ Easy  Cleaner
เพ่ือทำความสะอาดรจีสีตรีได้โดยอตัโนมติั
ให้คุณคลิกที่ปุ่ม Registry เพื่อเริ่มต้นทำงาน
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ลดความแออดัยัดเยียด
ในขณะที ่ค ุณท่องเว็บ พีซีของคุณจะ

สะสมไฟลต์า่งๆ ไปเรือ่ยๆ  ส่วนบราวเซอรก์จ็ะ
รวบรวมข้อมูลของเว็บไซต์ต่างๆ ที ่คุณไป
เยี่ยมเยียมเก็บไว้ในแคช สิ่งนี้หมายความว่า
คุณสามารถย้อนกลับไปยังไซต์ท ี ่ เคยไป
เยี่ยมชมก่อนหน้านี้ได้อย่างรวดเร็ว แต่ก็ยังมี
เพจอีกเป็นจำนวนมากที ่คุณเจอ และคุณ
ไม่อยากกลับไปดูอีก ด้วยเหตุนี้คุณจึงควรที่
จะลบแคชเหล่านี้ทิ้งไปให้บ่อยครั้งที่สุดเท่าที่
จะทำได้

คุ๊กก้ี
พีซีของคุณไม่ได้ทำแคชเว็บไซต์ต่างๆ

เท่าน้ัน ไซต์หลายแห่งท้ิงคุ๊กก้ีเอาไว้ในฮาร์ดดิสก์
ของคุณด้วย คุ๊กก้ีมักเป็นไฟล์ข้อความขนาดเล็ก
ซ่ึงบันทึกข้อมูลง่ายๆ เก่ียวกับตัวคุณเอาไว้เพ่ือ
ทำให้การเข้าไปในเว็บไซต์เหล่านี้ในภายหลัง
มีประสิทธิภาพดีขึ ้น รายละเอียดที่จัดเก็บ
เอาไวอ้าจประกอบดว้ย คำตอบทีค่ณุกรอกลง
ไปในแบบฟอร์มออนไลน์ หรือข้อมูลที่ระบุว่า
คุณเข้าไปเยี่ยมชมส่วนใดของเว็บไซต์บ้าง

โดยปกติแล้วการทำงานของคุ๊กกี้จะเป็น
ไปในแบบที่มีความรับผิดชอบ และใช้พื้นที่ใน
พีซีของคุณน้อยมาก อย่างไรก็ตามเจ้าของไซต์
บางแห่งใช้คุ๊กกี้เพื่อติดตามกิจกรรมของผู้คน
ในอินเทอร์เน็ต ซึ่งทำให้การรวบรวมข้อมูล
สำคัญของคุณช้าลง

ผู ้คนจำนวนมากกังวลเกี ่ยวกับเรื ่องนี ้

ด้วยเหตุนี ้ Internet Explorer จึงมีระบบ
ควบคุมการรักษาความลับของผู ้ใช้ติดตั ้ง
เอาไว้ใน  Internet Explorer วิธีการก็คือ เข้าไป
ท่ีเมนู Tools>Internet Options>Privacy และ
ใช้สไลเดอรเ์พือ่กำหนดระดบั  Privacy  Level
อย่างไรก็ตามคุณอาจจำเป็นต้องข้ามการทำงาน
ของคณุสมบตัขิอ้นี ้เพือ่ทำใหเ้วบ็ไซตบ์างแหง่
ใช้การได้ ดังนั ้นคุณต้องคลิก Edit พิมพ์
แอดเดรสของไซต์ที่คุณต้องการให้ข้ามการ
ทำงานของคุณสมบัติข้อน้ี แล้วคลิก Allow คุ๊กก้ี
เป็นแควิ่ธีการอยา่งหนึง่ท่ีบริษัทท่ีไม่มีศีลธรรม
และตัวแทนใช้รวบรวมข้อมูลส่วนตัวตน และ
พีซีที่คุณใช้อยู่ เพื่อสะสมเป็นข้อมูลเกี่ยวกับ
การทำตลาดของตนเอง นอกจากนั้นคุณอาจ
ติดตั้งโปรแกรมที่ดูเหมือนไม่มีพิษไม่มีภัยใดๆ
แต่ที ่จริงโปรแกรมเหล่านี้อาจมีของแถมซึ่ง
คุณไม่ต้องการติดมาด้วย

โปรแกรมจำนวนมาก (โดยเฉพาะอยา่งย่ิง
เกมต่างๆ) มีองค์ประกอบของสปายแวร์ที ่
ทำให้ระบบของคุณมีประสิทธิภาพลดลง
เนื่องจากมันทำงานในโหมดแบกกราวน์ เพื่อ
รวบรวมข้อมูลส่วนตัวของคุณและบันทึกกิจกรรม
ต่างๆ ของคุณเอาไว้ เมื่อใดก็ตามที่โปรแกรม
เหล่านี้ส่งข้อมูลที่คันหาเจอผ่านอินเทอร์เน็ต
ระบบสื ่อสารของคุณจะได้ร ับผลกระทบ
เน่ืองจากคุณกำลังส่งข้อมูลเพ่ิมเติมโดยไม่รู้ตัว
ขณะใช้อินเทอร์เน็ตอยู่

สปายแวร์มักเขียนข้ึนมาได้ไม่ดี ดังน้ันจึงมี
การใช้ทรัพยากรต่างๆ อย่างสิ้นเปลืองโดยไม่
จำเป็น จากน้ันคุณยังมักพบว่าเมมโมรีของคุณ
ลดลงและซพีียูถูกใช้เพ่ือประมวลผลคำสัง่ของ
สปายแวรอี์กดว้ย  โชคดทีีไ่มโครซอฟทค์ดิคน้
โซลูชันทำความสะอาดสปายแวร์ขึ้นมา โดย
คุณสามารถดาวน์โหลดโปรแกรม Microsoft
Antispyware ไปใช้ได้จากเว็บไซต์ www.
microsoft.com/athome/security/spyware/
software/default.mspx โดยการใช้งาน
ให้คุณเลือกวิธีป้องกันแบบ Real-Time Security
Agent  วิธีนี้คล้ายคลึงกับระบบป้องกันอย่าง
ต่อเน่ืองของโปรแกรมปอ้งกันไวรัส ให้คุณคลิก
ที่ Run Scan Now เพื่อเริ่มต้นการสแกนหา
สปายแวร์เป็นคร้ังแรก ซ่ึงหลังจากทำการสแกน
เสร็จแล้ว คุณจะเห็นหน้าจอสรุปผลลัพธ์และ
ตัวเลือกสำหรับลบไฟล์ทิ้งไป

ทำความสะอาดแคช
แม้ว่าไม่มีสปายแวร์มาทำให้ระบบของคุณ

ทำงานช้าลงก็ตาม แต่คุณอาจพบว่าไฟล์
อินเทอรเ์นต็ทีส่ะสมเพิม่มากขึน้เรือ่ยๆ กท็ำให้
ส่ิงต่างๆ ช้าลงได้เช่นกัน ซ่ึงการทำความสะอาด
แคชเหล่านี้คุณต้องอาศัยควบคุมไฟล์เหล่านี้
จาก Internet Options โดยใหค้ลกิที ่Setting
ในหัวข้อ General จากน้ันเลือกขนาดท่ีเหมาะสม
สำหรับแคชถ้าหากต้องการลบไฟล์แต่ละไฟล์ให้
เลือกเมนู View Files จากกรอบ Settings เลือก
ไฟล์ท่ีคุณต้องการกำจัดท้ิงไปจากน้ันคลิก Delete

ส่วนเมนู History จัดเป็นวิธีการท่ีมีประโยชน์
เพื่อช่วยให้คุณเข้าไปในเว็บไซต์ที่คุณเคยไป
เย่ียมชมมาแล้วได้เร็วข้ึน แต่ข้อมูลส่วนน้ีก็อาจ
ไร้ระเบียบเช่นกัน ให้คุณคลิกท่ีปุ่ม History เพ่ือ
เรยีกชอ่ง History ขึน้มา เลอืกเมน ูView, By
Site เพื่อจัดเรียงชื่อไซต์ตามลำดับตัวอักษร
ในตอนน้ีคลิกเม้าส์ปุ่มขวาท่ีคุณต้องการลบทิง้
แลว้เลอืก Delete

นอกจากนั้น คุณยังอาจพบว่ารายการ
Favorites  ของคณุกอ็าจมจีำนวนเพิม่มากขึน้
เรือ่ยๆ ไดเ้ชน่กนัเมือ่เวลาผา่นไป คณุสามารถ
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กดปุ่ม [Shift] ค้างเอาไว้  แล้วคลิก Organize
Favorite เพื่อจัดการกับรายการต่างๆ
ภายในวนิโดวส ์Windows Explorer เอง

โปรแกรม Microsoft AntiSpyware ทีค่ณุสามารถ
ดาวนโ์หลดมาใชไ้ด้จะสแกนระบบของคณุ
และลบสปายแวร์ใดๆ ที่เจอให้

ในบางครัง้ฝุ่นก็อาจทำใหพี้ซีหยุดทำงานได้
“เพื่อนแฟนของผมทราบว่า ผมทำงานด้านซ่อมคอมพิวเตอร์เขาจึงเสนอให้น้ำ

อัดลมผมหนึง่กระปอ๋ง ถา้หากผมทำใหพ้ซีีของเขาใชง้านไดอี้กครัง้หนึง่ เขาบน่เสมอวา่
พีซีมักแฮงก์บ่อยๆ  ถ้าหากเขาใช้งานเกินหนึ่งชั่วโมง  เรื่องนี้ฟังดูแล้วเหมือนเครื่อง
มีปัญหาเรื่องความร้อน ดังนั้น ผมจึงเปิดฝาตัวถังเพื่อตรวจดูด้านในผมพบว่าพัดลม
เต็มไปด้วยฝุ่นและขนสัตว์เต็มไปหมด  และเมื่อผมเปิดฝาครอบด้านหน้าของตัว
เครื่องออก ผมก็พบว่ามีขนสัตว์ติดอยู่เต็มไปหมดทุกรูเช่นกัน ผมทำการดูดฝุ่นทั้งหมด
ออกอยา่งระมดัระวงั จากนัน้พซีี เครือ่งนัน้กใ็ช้งานไดต้ามปกต”ิ

ประสบการ์ณจริงจาก....ช่างซ่อมคอมฯ Zeer รังสิต

จัดระเบียบรายการเหล่านี้ได้โดยเลือกเมนู
Favorites ใน Internet Explorer คลิกเม้าส์
ปุ่มขวาทีหั่วข้อใดหัวข้อหน่ึง จากน้ันเลือก Sort
By Name นอกจากนั้นคุณยังสามารถลบ
รายการ Favorites ท่ีคุณไม่จำเป็น ต้องใช้ท้ิงไป
ได้โดยงา่ยอกีดว้ย  ถ้าหากตอ้งการจดัระเบยีบ
รายการทีอ่ยู ่ในวนิโดวส ์Windows Explorer
ให้เข้าไปในเมนู Favorites กดปุ่ม [Shift]
ค้างเอาไว้ แล้วคลิกที่ Organize Favorites
จากนั้นจัดระเบียบไฟล์และโ ฟลเดอร์ต่างๆ
คุณสามารถจัดเก็บ  Favorites ที่คุณใช้งาน
เป็นประจำ เอาไว้ในทูลบาร์ Links ซึ่งคุณยัง
คลิกตรงจุดนี้เพื่อเข้าไปในรายการสั้นๆ ของ
ไซต์ต่างๆ ได้อย่างรวดเร็วอีกด้วย ถ้าหาก
ต้องการเพ่ิมรายช่ือ ไซต์ใหม่ลงไป ให้ลาก URL
จากชอ่ง Favorites ลงไปในทลูบาร ์Links

นอกเหนือจากนั้นไฟล์อินเทอร์เน็ตยังเข้า
สู่พซีีของคณุในรปูของ อีเมลไ์ดด้ว้ย ซ่ึงการลด
จำนวนของข่าวสารที่อยู่ในอินบอกซ์จะทำให้
Outlook  และ Outlook Express ตอบสนอง
ได้เร็วขึ้นกว่าเดิม ให้คุณ จัดเรียงข่าวสารใน
อินบอกซ์โดยดูจากวันที่ จากนั้นกำหนดจุดที่
จะลบข้อมูลทิ้ง แล้วจึงทำการไฮไลท์ข่าวสาร
ทัง้หมด ทีเ่ขา้มากอ่นวนัทีน่ี ้จากนัน้ทำการลบ
ข่าวสาร นอกจากนั้นคุณยังอาจต้องการเก็บ
ข่าวสารบางชิน้เอาไว ้โดยการเซฟเกบ็ไว้ยังจุด
อ่ืนๆ กไ็ด้

การกำหนดตัวแปรแบบ  High Privacy
อาจปอ้งกนัคุก๊กีท้ัง้หมดได้ แตวิ่ธกีารนีอ้าจทำให้
เว็บไซต์บางแห่งไม่อาจทำงานได้
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01 การด์กราฟกิ
พัดลมที่ตัวถังจะทำการดูดอากาศเข้ามา

ในพีซี  ดังน้ันมันจึงเป็นตัวดูดฝุ่นได้เป็นอย่างดี
คุณสามารถทำความสะอาดพัดลมในการ์ดกราฟิก
โพรเซสเซอร์ฮีตซิงก์ และภายในตวัถังได้โดยใช้
แปรงวาดภาพทัว่ไป คุณต้องถอดการ์ดออกมา
อย่างระมัดระวัง จากนั้นนำกราฟิกกลับเข้าที่
หลังจากทำความสะอาดแล้ว

02 พดัลมตวัถงัและโพรเซสเซอร์
พัดลมบางชนิดถอดออกมาทำความสะอาด

ได้ยากมาก ถ้าหากเป็นสถานการณ์แบบนี้
คุณจำเป็นต้องใช้แปรงทำความสะอาดใบพัด
ด้านในอย่างระมัดระวัง และใช้เศษกระดาษ
คอยรับสิ่งสกปรกที่หล่นลงมา แต่คุณไม่ควร
ทำความสะอาดส ิ ่ งสกปรกในแผงวงจร
โดยเดด็ขาด เนือ่งจากอาจเกดิไฟฟา้สถติยจ์น
ทำใหช้ิ้นสว่นเสยีหายได้

03 พาวเวอรซั์พพลาย
อย่าใช้แปรงทำความสะอาดพัดลมของ

พาวเวอร์ซัพพลายเป็นอันขาด มิฉะน้ันแล้วคุณ
อาจถูกไฟดูดได้ แต่คุณควรใช้แรงดันอากาศ
เพื่อเป่าให้ฝุ ่นหลุดออกไป หรือคุณอาจใช้
เครื ่องดูดฝุ ่นที ่มีหัวที ่เหมาะสมดูดเอาสิ ่ง
สกปรกออกมากไ็ด้ ถ้าหากมฝุ่ีนจับมากเกนิไป
คุณอาจจะหาพาวเวอร์ซัพพลายตัวใหม่มาใช้
จะดีกว่า  แต่คุณไม่ควรแกะพาวเวอรซั์พพลาย
เองโดยเด็ดขาด

ผลพวงของการทำงานหนกัของคณุกค็อื พีซีทีส่ะอาดเหมอืนใหมท่ัง้ภายในและภายนอก
สำคญัทีค่ณุต้องไมห่วนกลบัไปใช้นสัิยเดมิอกี

การทำความสะอาดพัดลม


